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[bookmark: _Toc190248697]Abstract
Insert your title here, which should be the same as the one on your title page: Single space if more than one line

Insert your name

[bookmark: _Hlk23935461][bookmark: _Hlk23935201]Begin typing the text of your Abstract here. The Abstract should summarize the contents of your thesis or project and should be able to stand alone. Emphasis should be on what you found. The Abstract should include the following elements: the key topic or problem, your main approach (methods), one or two important results, and a brief discussion/interpretation of your results or a note of your main conclusion. For examples of abstracts, see the Graduate Studies website, the Thesis Canvas Course, or completed Cal Poly Humboldt theses on Humboldt Digital Commons. Abstracts are read by those who are trying to decide whether or not to read the main document, or who want to get the big picture before reading the main document. The Abstract should not exceed 250 words (approximately 1.5 pages). Literature citations and footnotes are not allowed. Page numbers on the preliminary pages are lower case Roman numerals placed center-bottom. The title page is not numbered, but is assumed to be page “i”. Therefore, the Abstract is page “ii”.

To paste content from Google Docs or another platform into the template, right-click where you want the text, and under “Paste Options,” select the “Keep Text Only” option (symbol: clipboard with an A). If the text includes any bolding, italics, underlines etc., then select the “Merge Formatting” option (symbol: clipboard with an →) to retain those features. This will ensure content meets the formatting requirements.  Delete this text box when you are done.

[bookmark: _Toc190248698]Acknowledgements
Begin the text of your acknowledgements here. Acknowledgements are optional, unless your study was funded. If you received funding for your graduate project be sure to list the source. This is your chance to thank all of the people who helped you in designing, carrying out, and writing your project. If you are not including an acknowledgements section delete this page.
Once you have pasted your content into Microsoft Word, you will need to continue working on the file through the Microsoft Word software platform. Working on a Microsoft Word file in Google Docs can introduce errors in the formatting. 
The following will help you see the heading and page formatting:
· Turn on your Navigation Pane – View>Show>Navigation Pane
· Turn on your hidden characters. Mac – in Search box type “show invisibles”. PC – select the ¶ button under the Home tab.
Download the latest version of Microsoft Office for free HERE. Delete this text box when you are done.
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The Table of Contents (TOC) is automatic produced. There is no need to type anything into it. When you have finished adding all your text to the template, right-click in the Table of Contents, select the option “Update Field,” click “Update Entire Table,” then click “OK.” If you applied the appropriate style (e.g., Heading 1 etc.) to your headings in the text, the headings and page numbers will update automatically when you update the TOC. Delete this text box when you are done.


[bookmark: _Toc190248700]List of Tables
Table 1	5

The List of Tables is automatically produced. There is no need to type anything into it. When you have finished adding your text to the template, right-click the “Table 1” text listed above, select the option “Update Field,” click “Update Entire Table,” then click “OK.” If you applied the appropriate linked captions to your figures and tables (via the Insert Caption option under Reference tab), the captions and page numbers will update automatically when you update the TOC. Delete this text box when you are done.

[bookmark: _Toc190248701]List of Figures
Figure 1	6
The List of Figures is automatically produced. There is no need to type anything into it. When you have finished adding all text to the template, right-click the “Figure 1” text listed above, select the option “Update Field,” click “Update Entire Table,” then click “OK.” If you applied the appropriate linked captions to your figures and tables (via the Insert Caption option under Reference tab), the captions and page numbers will update automatically when you update the TOC. Delete this text box when you are done.
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The List of Appendices is automatically produced. There is no need to type anything into it. When you have finished adding all appendices to the template, right-click the “Appendix A.” text listed above, select the option “Update Field,” click “Update Entire Table,” then click “OK.” If you applied the appropriate linked appendix captions (see directions in the APPENDICES section), the captions and page numbers will update automatically when you update the TOC. Note: If you only have one appendix, then you would include “APPENDIX” in the Table of Contents and delete this page. Delete this text box when you are done.
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[bookmark: _Toc190248703]Introduction
[bookmark: _Hlk23936736][bookmark: _Hlk23951045]A thesis or project is the written product of a systematic study of a significant problem. It identifies the problem, states the major assumptions, explains the significance of the undertaking, sets forth the sources for and methods of gathering information, analyzes the data, and offers a conclusion or recommendation. The finished product evidences originality, critical and independent thinking, appropriate organization and format, and thorough documentation.
The Introduction section should set the context for the work to be reported. It should also establish the purpose and importance of that work and answer the question, “What did you study?” Per the State of California’s Title 5 Education Code, this is where you will “clearly identify the problem, state the major assumptions, [and] explain the significance of the undertaking.”
[bookmark: _Hlk24969350]Body text page numbers will start with Arabic numerals starting with “1.” Theses should be typed in Times New Roman 12-point font. You may reduce the font size to 10pt within tables or figures to fit within margins. Text must be double spaced, except for captions, quoted passages that may be indented and single-spaced for emphasis, or within the Table of Contents or List of Figures/Tables when a heading or caption title wraps to a second line. Text must be left aligned. To see the paragraph, page, and section breaks throughout the document, click the ¶ symbol under the home tab. 
Please note that the structure of this template is just a suggestion. Please be sure to discuss the proper structure for your thesis or project with your advisor. Please install the latest version of Microsoft Word by downloading the free Microsoft Office software suite at https://hsu-forms.humboldt.edu/software/.
[bookmark: _Toc190248704]Styles
This template makes use of a feature in Microsoft Word called Styles. Styles enable you to build an automatic table of contents, consistently format headings, and create a tagged accessible PDF. Each heading level one (e.g. Introduction) should be capitalized, bold, and centered at the top of a new page.
APA headings 1 through 5 are already set up in this template. The built-in heading styles need to be applied to each heading in your document. You can see what headings have been applied by going to the View tab and clicking on “Navigation Pane.” Regardless of the number of heading levels, always use headings in order beginning with level one. For help using Styles or updating the Tables of Contents refer to the Thesis Canvas Course sections on Headings and Subheadings and Table of Contents.
[bookmark: _Toc190248705]Heading Level Two
[bookmark: _Hlk24986634]If you want subheadings under your heading level 1 titles, use heading level two. Heading level two titles should use title capitalization and be bold and left-aligned.
[bookmark: _Toc190248706]Heading Level Three
If you want subheadings under the heading level 2 headings, use heading level three. This heading is left-aligned, bold, and italicized. It uses title case capitalization.
Heading Level Four. This heading is indented with the paragraph and ends with a period. The text is bold and uses title case capitalization. Be careful when applying the heading style so that the rest of the paragraph remains as normal text. To apply a heading: 1) type the heading and the following paragraph, 2) highlight the heading, and 3) select heading level four in the Styles menu.
Heading Level Five. This heading is indented with the paragraph and ends with a period. The text is bold and italicized and uses title case capitalization. Be careful when applying the heading style so that the rest of the paragraph remains as normal text. To apply a heading: 1) type the heading and the following paragraph, 2) highlight the heading, and 3) select heading level four in the Styles menu.


[bookmark: _Toc190248707]Methods
Begin your methods section here. The methods section describes what you used and how you did your study. This section must be sufficiently detailed so that a reasonably competent colleague would be able to repeat your work. Reproducibility is an essential cornerstone of the scientific method. This section should include your research design or approach; population and/or sample; collection and tabulation of data; and data analysis procedures. Be sure to avoid unnecessary details about common laboratory equipment (e.g. microscopes, balances, notebooks, etc.) and procedures (e.g. standard statistical analyses).
If you worked with vertebrate animals, your Institutional Animal Care and Use Committee (IACUC) approval number and date must be included in your methods. If you worked with Human Subjects in your research, your Institutional Review Board (IRB) approval number and date must be included in your methods.
Your methods may require a detailed description of the study site. The study site section can be a sub-section within your methods or it can be a stand-alone section just before the methods section. It is always a good idea to provide a site map of where you conducted your study.
[bookmark: _Toc190248708]Tables
[bookmark: _Hlk24988201][bookmark: _Hlk23863465][bookmark: _Hlk187066554]If you present data in table form, use the “Insert Table” tool to create accessible tables in your document. Tables should have clear column headings to provide context and assist in navigation of the table’s contents (Table 1). Identify the top row of the table as a Repeat Header Row in the Table Tools, Layout tab. Note: Do not use tabs or spaces to create tables, or import a table as an image. It may look like a table; however, it will not be accessible or readable by assistive technologies. Avoid merging or splitting cells. All rows and columns should have the same number of cells. Titles that refer to the entire table (or entire table sections) should not be included in the table structure. Either put them in the caption, or if necessary, integrate them into each column of the header row (or into each row of the first column as applicable). Keep tables from breaking over pages unless the table is too long to fit on a single page. 

[bookmark: _Toc190248733][bookmark: _Toc424044030]Table 1 
Example of a Table Layout
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[bookmark: _Toc190248709][bookmark: _Hlk25243368][bookmark: _Hlk23863748]Captions
Captions should be placed above the table. The table number should be bold and the caption italicized underneath it using title capitalization. You can add captions by using the “Insert Caption” feature found in the Refences tab or by right-clicking the table. This will create linked captions and allow you to automatically update the List of Tables in the preliminary pages of this template. Using linked captions will also sequentially number your tables (Table 1, Table 2, etc.), allowing you to refer to them in the text. For help using Tables refer to the Thesis Canvas Course section on Tables.
[bookmark: _Toc190248710]Figures 
[bookmark: _Toc190248711]Captions and Alternate Text
[bookmark: _Hlk23864283]Alternative text (Alt Text) is a word or phrase that conveys the same essential information as the figure. Alternative text allows people with screen readers to understand the content of your pictures, charts, graphs and tables. You will need to add alternative text to comply with the accessibility requirements. It is unnecessary to begin a description with “photo of” or “picture of.” If the information contained in the figure is fully described in the document text or in the figure caption enter “refer to text” or “refer to caption” in the Alt Text description box (Figure 1). To enter Alt Text, right-click the figure and select the Edit Alt Text option. 
[bookmark: _Hlk23950352][bookmark: _Hlk23863844]Captions should be placed above the figure. The figure number should be bold and the caption italicized underneath it using title capitalization. Use the “Insert Caption” feature found in the Microsoft Word references tab to insert a caption. This will allow you to automatically update the List of Figures in the preliminary pages of this template. Using captions will also sequentially number your figures (Figure1, Figure 2, etc.), allowing you to refer to them in the text. For help using Figures refer to the Thesis Canvas Course section on Figures.
[bookmark: _Toc190249404]Figure 1 
An Example of Using Patterns and Labels to Address Accessibility
[image: ]

[bookmark: _Toc190248712]Resolution and Color
Figures should have high enough resolution to be read and understood easily (at least 300 dpi). Color cannot be used as the only means to convey context or information. This should not in any way discourage the use of color on a page, or even color coding if it is accompanied by other visual indications. To check if an image will be colorblind accessible, click on your image, select the Format tab, then Color, and Grayscale, and then evaluate if any meaning is lost when viewed in this manner. Options include using patterns instead of solid colors or lines, using colorblind accessible color schemes that render in distinctly different shades when viewed in grayscale, using text signifiers to differentiate information, or if none of these options are possible, using expanded captions or alternative text to summarize the primary takeaway of the figure. 


[bookmark: _Toc190248713]Results
Begin your results section here. In the results section you present your findings. This is harder than it seems because often you are presenting data. Sometimes, data can be effectively presented in tables or figures. However, anything you present must be meaningful and should never be redundant. That is, you do not have to present every scrap of data. And you should not present the same data in a table and figure. If you present the majority of data in a table, use the text to point out the highlights from that table.
In scientific writing, one digit numbers are usually given word names (e.g. one, two, etc.) when mentioned in the text. Numbers with two or more digits are not spelled out (e.g. 10, 11, etc.). A fraction is always spelled out in the text unless it is part of a mixed fraction that is large enough to be expressed by numerals. Numerals are used to express quantities combined with abbreviations and symbols. 
Decimals and percentages are expressed in Arabic numerals. Note that unless it follows a number (e.g., 50%), “percent” or “percentage” is correct. Use only “%” in tables and figures. For table entries with a value less than one, always precede the decimal point with a "0" (e.g. 0.24 not .24). 
All reported measurements and units should be metric (if this is the convention in your discipline). Abbreviations of units should be consistent and standard. Avoid the use of periods after abbreviations (cm not cm.). Be consistent in your usage. If you use cm for centimeters, use m for meters. Acronyms should be used sparingly. Spell out the acronym the first time it is mentioned (e.g., “Data were acquired by the United States Department of Agriculture (USDA)”) and then use the acronym for every subsequent mention.


[bookmark: _Toc190248714]Discussion
Insert the text of your discussion here. This is your chance to compare and contrast the results of your experiment or study with the previously published works of others. It also gives you a chance to present the principles, relationships, and generalizations shown by your results. You should, however, discuss and interpret your results, not just summarize your results. You should also point out any inconsistencies, exceptions, or lack of correlation in your results and offer possible explanations. Practical or theoretical implications of your work should also be noted. The discussion section is also the appropriate place to make recommendations for future research (if not included in a separate section).


[bookmark: _Toc190248715]Conclusions, Summary or Recommendations
Conclusions, recommendations or a summary may be included after the discussion. However, it is not required. Recommendations might be particularly appropriate if the work was done for a sponsoring agency to solve some problem in resource management. If you select ‘Summary’ as your header for this section you should summarize the entire research effort.


[bookmark: _Toc190248716]References
Insert references here. Please check with your committee and style manual for specific requirements. Select “Bibliography” from the Styles menu for a single-spaced, hanging indented list.
The Cal Poly Humboldt Library has information about citing your sources and citation management systems through the Citing your Sources research guide.
American Psychological Association. (2019). Publication manual of the American Psychological Association. American Psychological Association.


[bookmark: _Toc190248717]Appendices
[bookmark: _Toc396144592][bookmark: _Toc24990698][bookmark: _Toc190249422][bookmark: _Hlk24990316]Appendix A: Instructions for appendices
[bookmark: _Hlk24990999][bookmark: _Hlk23864893][bookmark: _Toc396144593]Appendices are used to include material too detailed or lengthy for inclusion in the body of the study (e.g., questionnaires, maps, photos, and letters of permission). If your document has one appendix, the heading should read “Appendix” and you do not need a List of Appendices page. If there are two or more appendices, the heading should read “Appendices” followed by alphabetically labeled captions (Appendix A, Appendix B, etc.) in the order they are referenced in your document. To do this, select Insert a Caption through the Reference tab and select the “Appendix” label. Once you’ve labelled all Appendices (Appendix A, Appendix B, etc.), you will be able to automatically update the List of Appendices in the preliminary pages of this template. Instructions for inserting captions and creating a linked list of appendices are available on the Thesis Canvas Course section on Appendices.
[bookmark: _Hlk24990485]

[bookmark: _Toc24990699][bookmark: _Toc190249423]Appendix B: Tables and figures
[bookmark: _Hlk187068669]Each appendix should start at the top of a new page. If tables or figures in the appendix (or anywhere else in your document) do not fit within the listed margins, consider making the page landscape. You can follow the instructions in this link. 
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